
 

 
 

Baustein zur Über-
wachung von 24V-
Verbraucherkreisen 

 
SITOP PSE200U, STEP 7 V5.5 
 

https://support.industry.siemens.com/cs/ww/de/view/61450284 

  
 

Siemens 
Industry 
Online 
Support 

https://support.industry.siemens.com/cs/ww/de/view/61450284


Gewährleistung und Haftung 

 

Baustein zur Überwachung von 24V-Verbraucherkreisen 
Beitrags-ID: 61450284,    V3.0,    03/2017   2 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Gewährleistung und Haftung 
 

Hinweis Die Anwendungsbeispiele sind unverbindlich und erheben keinen Anspruch auf 
Vollständigkeit hinsichtlich Konfiguration und Ausstattung sowie jeglicher Eventualitäten. 
Die Anwendungsbeispiele stellen keine kundenspezifischen Lösungen dar, sondern sollen 
lediglich Hilfestellung bei typischen Aufgabenstellungen bieten. Sie sind für den sach-
gemäßen Betrieb der beschriebenen Produkte selbst verantwortlich. Dieses Anwendungs-
beispiel enthebt Sie nicht der Verpflichtung zu sicherem Umgang bei Anwendung, 
Installation, Betrieb und Wartung. Durch Nutzung dieses Anwendungsbeispiels erkennen 
Sie an, dass wir über die beschriebene Haftungsregelung hinaus nicht für etwaige 
Schäden haftbar gemacht werden können. Wir behalten uns das Recht vor, Änderungen 
an diesem Anwendungsbeispiel jederzeit ohne Ankündigung durchzuführen. Bei 
Abweichungen zwischen den Vorschlägen in diesem Anwendungsbeispiel und anderen 
Siemens Publikationen, wie z. B. Katalogen, hat der Inhalt der anderen Dokumentation 
Vorrang. 

Für die in diesem Dokument enthaltenen Informationen übernehmen wir keine 
Gewähr. 
Unsere Haftung, gleich aus welchem Rechtsgrund, für durch die Verwendung der 
in diesem Anwendungsbeispiel beschriebenen Beispiele, Hinweise, Programme, 
Projektierungs- und Leistungsdaten usw. verursachte Schäden ist ausgeschlossen, 
soweit nicht z. B. nach dem Produkthaftungsgesetz in Fällen des Vorsatzes, der 
groben Fahrlässigkeit, wegen der Verletzung des Lebens, des Körpers oder der 
Gesundheit, wegen einer Übernahme der Garantie für die Beschaffenheit einer 
Sache, wegen des arglistigen Verschweigens eines Mangels oder wegen 
Verletzung wesentlicher Vertragspflichten zwingend gehaftet wird. Der Schadens-
ersatz wegen Verletzung wesentlicher Vertragspflichten ist jedoch auf den 
vertragstypischen, vorhersehbaren Schaden begrenzt, soweit nicht Vorsatz oder 
grobe Fahrlässigkeit vorliegt oder wegen der Verletzung des Lebens, des Körpers 
oder der Gesundheit zwingend gehaftet wird. Eine Änderung der Beweislast zu 
Ihrem Nachteil ist hiermit nicht verbunden. 

Weitergabe oder Vervielfältigung dieser Anwendungsbeispiele oder Auszüge 
daraus sind nicht gestattet, soweit nicht ausdrücklich von der Siemens AG 
zugestanden. 

 

Security-
hinweise 

Siemens bietet Produkte und Lösungen mit Industrial Security-Funktionen an, die den 
sicheren Betrieb von Anlagen, Systemen, Maschinen und Netzwerken unterstützen. 

Um Anlagen, Systeme, Maschinen und Netzwerke gegen Cyber-Bedrohungen zu sichern, 
ist es erforderlich, ein ganzheitliches Industrial Security-Konzept zu implementieren (und 
kontinuierlich aufrechtzuerhalten), das dem aktuellen Stand der Technik entspricht. Die 
Produkte und Lösungen von Siemens formen nur einen Bestandteil eines solchen 
Konzepts. 

Der Kunde ist dafür verantwortlich, unbefugten Zugriff auf seine Anlagen, Systeme, 
Maschinen und Netzwerke zu verhindern. Systeme, Maschinen und Komponenten sollten 
nur mit dem Unternehmensnetzwerk oder dem Internet verbunden werden, wenn und 
soweit dies notwendig ist und entsprechende Schutzmaßnahmen (z.B. Nutzung von 
Firewalls und Netzwerksegmentierung) ergriffen wurden.  

Zusätzlich sollten die Empfehlungen von Siemens zu entsprechenden Schutzmaßnahmen 
beachtet werden. Weiterführende Informationen über Industrial Security finden Sie unter 
http://www.siemens.com/industrialsecurity.  

Die Produkte und Lösungen von Siemens werden ständig weiterentwickelt, um sie noch 
sicherer zu machen. Siemens empfiehlt ausdrücklich, Aktualisierungen durchzuführen, 
sobald die entsprechenden Updates zur Verfügung stehen und immer nur die aktuellen 
Produktversionen zu verwenden. Die Verwendung veralteter oder nicht mehr unterstützter 
Versionen kann das Risiko von Cyber-Bedrohungen erhöhen.  

Um stets über Produkt-Updates informiert zu sein, abonnieren Sie den Siemens Industrial 
Security RSS Feed unter http://www.siemens.com/industrialsecurity. 

 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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1 Einführung 

1.1 Überblick  

Das elektronische Selektivitätsmodul SITOP PSE200U mit Einzelkanalmeldung ist 
ausgelegt zum Anschluss an eine geregelte 24V DC Stromversorgung mit einem 
Ausgangstrom von bis zu 40A. Mit dem Selektivitätsmodul wird die von einer 
geregelten Stromversorgung erzeugte Ausgangsspannung (24V DC) auf 4 
Verbraucherkreise aufgeteilt. Für jeden Ausgang kann der Nennstrom je nach Typ 
mit einem Potentiometer individuell im Bereich von 0,5 bis 3A bzw. im Bereich von 
3 bis 10A eingestellt werden. Bei Überschreitung des Nennstroms wird der 
Ausgang nach einer gewissen Zeit abgeschaltet und kann nach einer Wartezeit 
mittels Taster direkt am Selektivitätsmodul oder mittels Fern-Reset wieder 
eingeschaltet werden. 

1.2 Funktionsweise 

Der Status-Ausgang (S) des Selektivitätsmoduls liefert ein Signal, dass den 
Zustand der 4 Verbraucherkreise seriell codiert. 

Über einen digitalen Eingang wird das Signal des Status-Ausgangs (S) von der 
S7-CPU eingelesen und ausgewertet. Damit können Sie den Zustand der 
Ausgänge 1 bis 4 über das Anwenderprogramm der S7-CPU überwachen. 

Die S7-CPU erkennt, ob der am Ausgang 1 angeschlossene Verbraucher, z. B. ein 
Motor, eine Überlast erzeugt hat. 

Die S7-CPU erkennt, ob der am Ausgang 2 angeschlossene Verbraucher, z. B. 
eine Beleuchtung, einen Kurzschluss verursacht hat. 
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1.2.1 Einsatz mit S7-300/S7-400 

Die folgende Abbildung zeigt die Überwachung von 24V-Verbraucherkreisen durch 
das Selektivitätsmodul SITOP PSE200U und S7-300/S7-400 CPU. 

Abbildung 1-1 
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1.2.2 Wirkschema 

Die Bibliothek LSitop liefert den Funktionsbaustein "LSitop_PseDiag" für 
S7-300/S7-400 CPUs. Rufen Sie den Funktionsbaustein "LSitop_PseDiag" im 
Anwenderprogramm der S7-CPU auf, um das Signal des Status-Ausgangs (S) 
auszuwerten. Der Funktionsbaustein "LSitop_PseDiag" liest über einen Eingang 
das Signal des Status-Ausgangs (S) ein und zeigt an seinem Ausgang den 
Zustand der 4 Ausgänge des Selektivitätsmoduls an. 

Abbildung 1-2 
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1.2.3 Signalverlauf des Status-Ausgangs (S) 

Die Abbildung 1-3 zeigt den Signalverlauf des Status-Ausgangs (S). Ein 
Telegramm des Signals besteht aus einem Start-Bit und vier Channel-Bits, die 
jeweils durch ein Pause-Bit getrennt sind. Das Start-Bit ist immer "1" und die 
Pause-Bits sind immer "0". Die Channel-Bits signalisieren den Zustand der 
Ausgänge 1 bis 4. 

 

Abbildung 1-3 
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1.2.4 Funktionsfolgen des Funktionsbausteins "LSitop_PseDiag" 

Die Abbildung 1-4 zeigt die graphische Darstellung der Funktionsfolgen des 
Funktionsbausteins "LSitop_PseDiag". 

 

Abbildung 1-4 
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1.2.5 Intern verwendete Systemfunktionen für S7-300/S7-400 CPUs 

Für die S7-300/S7-400 CPUs werden intern im Funktionsbaustein 
"LSitop_PseDiag" folgende Anweisungen aufgerufen: 

 TIME_TCK (SFC 64): Die Systemfunktion TIME_TCK (SFC 64) liest die 
Systemzeit der CPU aus. Die Systemzeit ist ein Zeitzähler, der von 0 bis max. 
2147483647ms zählt. Bei einem Überlauf wird wieder ab "0" gezählt. Das 
Zeitraster und die Genauigkeit der Systemzeit beträgt 1ms. 
Im Funktionsbaustein "LSitop_PseDiag" wird die Systemzeit verwendet, um die 
Zykluszeit zu berechnen sowie die Länge der Impulse und Pausen zu 
ermitteln. 
Die Systemfunktion TIME_TCK (SFC 64) finden Sie in der Standard-Bibliothek 
im Ordner "System Function Blocks > Blocks". 

 TON (SFB 4): Der Systemfunktionsbaustein TON (SFB 4) erzeugt eine 
Einschaltverzögerung. Im Funktionsbaustein "LSitop_PseDiag" wird die 
Einschaltverzögerung bei der Generierung der Fehlermeldungen verwendet. 
Den Systemfunktionsbaustein TON (SFB 4) finden Sie in der Standard-
Bibliothek im Ordner "System Function Blocks > Blocks". 

Zeitwerte vergleichen 

Zum Berechnen der Zykluszeit und der Länge der Impulse und Pausen muss die 
gelesene Systemzeit größer sein als die im letzten Zyklus gelesene und 
gespeicherte Systemzeit sein, d. h. im Funktionsbaustein werden 
Vergleichsausdrücke verwendet, um den Inhalt zweier Variablen vom Datentyp 
TIME auf größer zu vergleichen. 

Zykluszeit berechnen 

Um die Zykluszeit zu berechnen, wird in jedem Zyklus die ausgelesene Systemzeit 
gespeichert und im nächsten Zyklus von der neu ausgelesenen Systemzeit 
subtrahiert. Die Zykluszeit darf max. 100ms betragen, damit jeder Impuls im 
Signalverlauf des Status-Ausgangs (S) erkannt werden kann. Wenn die Zykluszeit 
100ms überschreitet, gibt der Funktionsbaustein "LSitop_PseDiag" einen Fehler 
mit dem Wert 16#8001 am Ausgang "status" aus. 

Länge eines Impulses berechnen 

Um die Länge eines Impulses zu berechnen, wird die Systemzeit gelesen und 
gespeichert, wenn am Eingang "impulse" eine positive Flanke erkannt wird. Wenn 
anschließend eine negative Flanke erkannt wird, wird die Systemzeit erneut 
gelesen und gespeichert. Die bei einer positiven Flanke gespeicherte Systemzeit 
wird von der bei einer negativen Flanke gespeicherten Systemzeit subtrahiert. 

Länge einer Pause berechnen 

Um die Länge einer Pause zu berechnen, wird die Systemzeit gelesen und 
gespeichert, wenn am Eingang "impulse" eine negative Flanke erkannt wird. Wenn 
anschließend eine positive Flanke erkannt wird, wird die Systemzeit erneut gelesen 
und gespeichert. Die bei einer negativen Flanke gespeicherte Systemzeit wird von 
der bei einer positiven Flanke gespeicherten Systemzeit subtrahiert. 
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1.2.6 Funktionsweise des Selektivitätsmoduls 

Über mehrfarbige LED-Anzeigen an der Gerätefront wird der Betriebszustand der 
jeweiligen Ausgänge angezeigt. 

Tabelle 1-1 zeigt, welcher Betriebszustand dazu führt, dass die Ausgänge 1 bis 4 
im Signalverlauf des Status-Ausgangs (S) den Zustand 0 oder 1 annehmen. 

 

Tabelle 1-1 

LED-Anzeigen Betriebszustand Zustand Ausgang 1 bis 4 

aus Alle LED-Anzeigen: 

 Versorgungsspannung fehlt 

 Gerätehochlauf: Nach Abschluss 
des Gerätehochlaufs werden die 
Ausgänge unter Beachtung der 
eingestellten 
Zuschaltverzögerung 
eingeschaltet. 

Während des Gerätehochlaufs 
oder bei fehlender 
Versorgungsspannung erfolgt 
keine Signalisierung am 
Status-Ausgang. Der Zustand 
ist dauerhaft 0. 

LED-Anzeige einzelner Ausgang: 

 Ausgang defekt (interne 
Sicherung hat ausgelöst) 

0 

Leuchtet grün Normalbetrieb, Ausgang zugeschaltet 1 

Blinkt grün Überlast am Ausgang: 
Ausgangsstrom 101 bis 150% vom 
Ansprech-Schwellwert (für 5s 
zulässig) 

1 

Leuchtet rot Ausgang wegen Überlast automatisch 
abgeschaltet 

0 

Blinkt rot Ausgang bereit für Rücksetzen der 
automatischen Abschaltung durch 
Betätigung des Tasters am 
Selektivitätsmodul oder Fern-Reset 
(wirksam für alle automatisch 
abgeschalteten Ausgänge) 

0 

Blinkt orange Ausgang manuell über Taster am 
Selektivitätsmodul abgeschaltet: Der 
Zustand wird beim Ausschalten des 
Geräts gespeichert und kann nur über 
nochmalige Betätigung des Tasters 
wieder zurückgesetzt werden. 

0 

Rotes Lauflicht Geräteübertemperatur: Nach dem 
Abklingen der Übertemperatur 
können die Ausgänge wieder 
eingeschaltet werden. 

0 
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1.3 Verwendete Komponenten 

Dieses Anwendungsbeispiel wurde mit diesen Hard- und Softwarekomponenten 
erstellt. 

Tabelle 1-2 

Komponente Anzahl Artikelnummer Alternative 

SITOP PSE200U 3A mit 
Einzelkanalmeldung 
(Selektivitätsmodul) 

1 6EP1961-2BA31  SITOP PSE200U 
10A, Artikelnummer: 
6EP961-2BA41 

 SITOP PSE200U 3A 
NEC Class 2, 
Artikelnummer: 
6EP961-2BA51 
6EP961-2BA61 

S7-CPU 1 6ES7315-2EH14-0AB0  Jede beliebige 
S7-300/S7-400 CPU 

 IM 151-8(F) PN/DP 
CPU 

 IM 154-8(F/FX) 
PN/DP CPU 

DI 8/DO 8x24VDC/0,5A 1 6ES7323-1BH01-0AA0 Andere 
Digitaleingabemodule 
und Digitalausgabe-
module 

STEP 7 V5.5 SP4 1 6ES7810-4CC10-0YA5 Für die Projektierung der 
S7-CPU benötigen Sie 
STEP 7 V5.5 SP4 oder 
höher. 
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2 Engineering  

2.1 Schnittstellenbeschreibung 

Der Funktionsbaustein "LSitop_PseDiag" liest über seinen Eingang "impulse" den 
Status-Ausgang (S) des Selektivitätsmoduls ein, um den Signalverlauf des 
Statusausgangs (S) auszuwerten und den Zustand der Ausgänge 1 bis 4 am 
Ausgang "channelState" anzuzeigen. 

Die Abbildung 2-1 zeigt den Aufruf des Funktionsbausteins "LSitop_PseDiag" im 
Anwenderprogramm. 

Rufen Sie den Funktionsbaustein "LSitop_PseDiag" im Anwenderprogramm der 
S7-CPU zyklisch im OB1 oder in einem Weckalarm-OB mit max. 100ms auf. 

Die Zykluszeit darf max. 100ms betragen, damit jeder Impuls im Signalverlauf des 
Status-Ausgangs (S) erkannt wird. 

 

Hinweis Wenn die Zykluszeit 100ms überschreitet, gibt der Funktionsbaustein 
"LSitop_PseDiag" einen Fehler mit dem Wert 16#8001 am Ausgang "status" aus. 

 

Abbildung 2-1 
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Die folgende Tabelle zeigt die Parameter des Funktionsbausteins 
"LSitop_PseDiag". 

Tabelle 2-1 

Name P-
Typ 

Datentyp Kommentar 

impulse IN Bool Eingang über den das Signal des Status-Ausgangs 
des Selektivitätsmoduls eingelesen wird. 

Die Abbildung 1-3 zeigt den Signalverlauf des Status-
Ausgangs (S). 

reset IN Bool Bei positiver Flanke wird ein Reset ausgelöst. Alle 
Parameter (statische Variablen und Ausgänge des 
Funktionsbausteins "LSitop_PseDiag") werden 
zurückgesetzt. 
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Name P-
Typ 

Datentyp Kommentar 

done OUT Bool done = 1: Ein Telegramm wurde komplett und ohne 
Fehler ausgewertet. Der Zustand der Ausgänge 1 bis 
4 des Selektivitätsmoduls wird am  Ausgang 
"channelState" angezeigt.  Die Daten des Ausgangs 
"channelState" können übernommen werden. Der 
Wert done = 1 wird für einen Zyklus gesetzt. 

done = 0: Telegrammauswertung läuft oder kein 
Signal am Eingang "impulse" erkannt. 

busy OUT Bool busy = 1: Funktionsbaustein "LSitop_PseDiag" ist 
aktiv 

busy = 0: Wenn done=1 wurde ein Telegramm 
komplett und ohne Fehler ausgewertet. Der Zustand 
der Ausgänge 1 bis 4 des Selektivitätsmoduls wird am  
Ausgang "channelState" angezeigt.  Die Daten des 
Ausgangs "channelState" können übernommen 
werden. 

channelState OUT Byte Zustand der Ausgänge 1 bis 4 

Bit 0 = 1, wenn der Ausgang 1 den Zustand 0 hat 

Bit 0 = 0, wenn der Ausgang 1 den Zustand 1 hat 

Bit 1 = 1, wenn der Ausgang 2 den Zustand 0 hat 

Bit 1 = 0, wenn der Ausgang 2 den Zustand 1 hat 

Bit 2 = 1, wenn der Ausgang 3 den Zustand 0 hat 

Bit 2 = 0, wenn der Ausgang 3 den Zustand 1 hat 

Bit 3 = 1, wenn der Ausgang 4 den Zustand 0 hat 

Bit 3 = 0, wenn der Ausgang 4 den Zustand 1 hat 

Bit 4: nicht belegt 

Bit 5: nicht belegt 

Bit 6: nicht belegt 

Bit 7: nicht belegt 

Tabelle 1-1 zeigt eine Übersicht der Betriebszustände 
und den Zuständen der Ausgänge 1 bis 4. 

status OUT Word Statusanzeige: 

Wenn error = 1, wird am Ausgang "status" die 
Fehlernummer für einen Zyklus angezeigt. 

Wenn error = 0 wird am Ausgang "status" der Wert 
16#0000 angezeigt. 

error OUT Bool  error = 1: Es ist ein Fehler während der 
Abarbeitung der Routine aufgetreten. Der Wert 
error = 1 wird für einen Zyklus gesetzt. 

 error = 0: kein Fehler 

 

Hinweis Der Instanz-DB des Funktionsbausteins "LSitop_PseDiag" wird beim Aufruf des 
Funktionsbausteins "LSitop_PseDiag" generiert. Sie benötigen für jeden Aufruf 
des Funktionsbausteins "LSitop_PseDiag" einen eigenen Instanz-DB. Der 
Funktionsbaustein "LSitop_PseDiag" darf nicht mehrmals mit demselben 
Instanz-DB aufgerufen werden. 
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Statusanzeige 

Tabelle 2-2 

Wert am Ausgang 
"status" 

Bedeutung Abhilfe/Hinweis 

16#8001 Zykluszeit von 100ms 
überschritten 

Rufen Sie den Funktionsbaustein 
"LSitop_PseDiag" mit max. 100ms auf. 

16#8002 Am Eingang "impulse" 
wurde min. 6s kein 
Signalwechsel erkannt. 

 Prüfen Sie, ob der Status-Ausgang 
(S) des Selektivitätsmoduls am 
digitalen Eingang angeschlossen 
ist. 

 Prüfen Sie, ob Sie am Eingang 
"impulse" den richtigen digitalen 
Eingang angegeben haben. 

 Prüfen Sie, ob die 
Spannungsversorgung am 
Selektivitätsmodul angeschlossen 
ist. 

2.2 Integration ins Anwenderprojekt 

Nachfolgend sind die Schritte aufgeführt, um die Bibliothek LSitop in STEP 7 zu 
öffnen und in Ihr STEP 7 Projekt zu integrieren. Anschließend können Sie die 
Bausteine der Bibliothek LSitop nutzen. 

 

Hinweis Das Vorhandensein eines STEP 7 Projektes wird im Folgenden vorausgesetzt. 

 

1. Die Bibliothek finden Sie auf der HTML-Seite, von der Sie dieses Dokument 
geladen haben. Speichern Sie die Bibliothek 
"61450284_PSE200U_STEP7_V5_LIB_V23.zip" auf Ihre Festplatte. 

2. Entpacken Sie die Bibliothek. 

3. Öffnen Sie den SIMATIC Manager. 

4. Wählen Sie das Menü "Datei > Öffnen" ("File > Open") aus. 

5. Markieren Sie im Register "Bibliotheken" ("Library") die Bibliothek LSitop und 
klicken Sie auf die Schaltfläche "OK", um die Bibliothek LSitop zu öffnen. 

2.2.1 Integration der Bibliotheksbausteine in das STEP 7-Projekt 

1. Nachdem Sie die Bibliothek LSitop geöffnet haben, öffnen Sie Ihr 
STEP 7-Projekt. 

2. Kopieren Sie die Bausteine der Bibliothek LSitop in Ihr STEP 7-Projekt. Dazu 
markieren Sie im Bausteinordner der Bibliothek alle Bausteine und ziehen Sie 
diese per drag & drop in den Bausteinordner Ihres STEP 7-Projekts. 
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3. Legen Sie den Organisationsbaustein OB1 an. Öffnen Sie ihn und ziehen Sie 
nun per drag & drop den Funktionsbaustein "LSitop_PseDiag" in ein beliebiges 
Netzwerk. 

 

4. Geben Sie den zugehörigen Instanz-Datenbaustein an. Wenn der Instanz-
Datenbaustein nicht existiert, muss er generiert werden. 

 

5. Klicken Sie im Programmbausteinordner mit der rechten Maustaste auf den 
neu generierten Instanz-Datenbaustein und wählen Sie im Kontextmenü die 
Option "Objekteigenschaften" ("Object Properties") aus, um den 
Eigenschaftsdialog des Instanz-Datenbausteins zu öffnen. 
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6. Aktivieren Sie im Register "Allgemein – Teil 2" ("General – Part 2" die Funktion 
"Non-Retain", um den Instanz-DB beim Neustart der CPU mit den 
Anfangswerten zu überschreiben. 

 

7. Belegen Sie alle notwendigen Formalparameter mit Werten. 

 

8. Speichern und schießen Sie den Organisationsbaustein OB1. 
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2.2.2 Laden der Bibliotheksbausteine in die S7-CPU 

Nachfolgend sind die Schritte aufgeführt, um alle Bausteine Ihres 
Anwenderprogramms in die S7-CPU zu laden. 

Laden über TCP/IP 

Wenn Ihre S7-CPU eine integrierte PROFINET-Schnittstelle besitzt oder in Ihrer 
S7-Station ein Industrial Ethernet CP vorhanden ist, können Sie die 
Bibliotheksbausteine über TCP/IP in die S7-CPU laden. 

1. Stellen Sie sicher, dass Ihr PG/PC und die S7-CPU im gleichen Subnetz 
angeschlossen sind. 

2. Wählen Sie im SIMATIC Manager das Menü "Extras > PC/PG Schnittstelle 
einstellen" ("Options > Set PC/PG Interface"), um die PG/PC-Schnittstelle auf 
TCP/IP einzustellen. 
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3. Markieren Sie die S7-Station und wählen Sie das Menü "Zielsystem > Laden" 
("PLC > Download"), um das gesamte Projekt in Ihre CPU zu laden. 

 

Laden über MPI 

Sie können die Bausteine auch über die MPI-Schnittstelle bzw. MPI/DP-
Schnittstelle in die S7-300/S7-400 laden. 

1. Mit einer PROFIBUS Busleitung oder einem MPI Kabel schließen Sie das 
PC/PG an die MPI- bzw. MPI/DP-Schnittstelle der S7-300/S7-400 CPU an. 

2. Wählen Sie im SIMATIC Manager das Menü "Extras > PC/PG Schnittstelle 
einstellen" ("Options > Set PC/PG Interface"), um die PG/PC-Schnittstelle auf 
MPI einzustellen. 

3. Stellen Sie im Dialog "PG/PC-Schnittstelle einstellen" den entsprechenden 
Zugriffsweg ein, z. B. CP5711.MPI. Übernehmen Sie die Einstellung mit "OK". 
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4. Markieren Sie die S7-Station und wählen Sie das Menü "Zielsystem > Laden" 
("PLC > Download"), um das gesamte Projekt in Ihre CPU zu laden. 

 

2.2.3 Aktualisierung der Bibliothek 

Die folgende Anleitung zeigt, wie Sie die Bibliothek auf Aktualität prüfen und wie 
Sie eine neuere Version der Bibliothek LSitop in Ihr STEP 7-Projekt integrieren. 

1. Führen Sie nachfolgende Schritte für den Funktionsbaustein „LSitop_PseDiag“ 
der Bibliothek LSitop aus: 

– Klicken Sie mit der rechten Maustaste auf den Funktionsbaustein und 
wählen Sie im Kontextmenü die Option "Objekteigenschaften (Object 
Properties)" aus. Der Eigenschaftsdialog des Funktionsbausteins wird 
geöffnet. 

– Vergleichen Sie im Register "Allgemein – Teil 2 (General – Part 2)" im 
Ausgabefeld "Version" die aktuelle Versionsnummer mit dem neuesten 
Stand vom Siemens Industry Online Support. 
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2. Um die Bausteine der Bibliothek in Ihrem STEP 7-Projekt zu aktualisieren, 
integrieren Sie die aktuellste Version der Bibliothek LSitop in STEP 7 (siehe 
Kapitel 2.2.1). 

3. In Ihrem STEP 7-Projekt löschen Sie alle Bausteine der Bibliothek unter dem 
Ordner "Bausteine". 
Hinweis 

Löschen Sie nicht den Funktionsbausteinaufruf im OB1. 

löschen

 

4. Wie in Kapitel 2.2.1 bis Schritt Nr. 3 beschrieben, fügen Sie die neueste 
Version der Bausteine aus der Bibliothek LSitop in Ihr STEP 7-Projekt ein. 

5. Die aktualisierten Bausteine sind nun eingefügt. Der ursprüngliche Aufruf des 
Funktionsbausteins "LSitop_PseDiag" zeigt jedoch immer noch einen 
fehlenden Instanz-DB an. 
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6. Wählen Sie das Menü "Zugriffe prüfen und aktualisieren" ("Check and Update 
Accesses"), um alle Operanden auf Typverträglichkeit zu prüfen und im 
Fehlerfall rot zu markieren. Alle Instanz-DBs werden aktualisiert und neu 
aufgebaut. 
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2.3 Fehlerhandling 

Status 16#8001 

Die Abbildung 2-2 zeigt die grafische Darstellung der Funktionsfolgen des 
Funktionsbausteins "LSitop_PseDiag" im Fehlerfall, z. B. wenn die Zykluszeit von 
100ms überschritten wird. 

Wenn die Zykluszeit länger als 4s größer als 100ms beträgt, dann wird 

 der Ausgang "error" für einen Zyklus auf TRUE gesetzt 

 am Ausgang "status" für einen Zyklus der Wert 16#8001 ausgegeben. 

 der Ausgang "busy" auf FALSE gesetzt 

Solange die Zykluszeit mehr als 100ms beträgt, wird alle 4s für einen Zyklus der 
Ausgang "error" auf TRUE gesetzt und am Ausgang "status" der Wert 16#8001 
ausgegeben. 

Der Ausgang "busy" wird erst wieder auf TRUE gesetzt, wenn die Zykluszeit 
weniger als 100ms beträgt und am Eingang "impulse" ein Signalwechsel erkannt 
wird. 

 

Abbildung 2-2 
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Status 16#8002 

Die  zeigt die grafische Darstellung der Funktionsfolgen des Funktionsbausteins 
"LSitop_PseDiag" im Fehlerfall, z. B. wenn das Selektivitätsmodul defekt ist und 
kein Signal am Status-Ausgang liefert. Somit bleibt am Eingang "impulse" des 
Funktionsbausteins "LSitop_PseDiag" der Signalwechsel aus. 

Wenn der Signalwechsel länger als 6s ausbleibt wird: 

 der Ausgang "error" für ein Zyklus auf TRUE gesetzt. 

 am Ausgang "status" für ein Zyklus der Wert 16#8002 ausgegeben. 

 der Ausgang "busy" auf FALSE gesetzt. 

Solange der Funktionsbaustein "LSitop_PseDiag" keinen Signalwechsel am 
Eingang "impulse" erkennt wird alle 6s für einen Zyklus der Ausgang "error" auf 
TRUE gesetzt und am Ausgang "status" der Wert 16#8002 ausgegeben. 

Der Ausgang "busy" wird erst wieder auf TRUE gesetzt, wenn am Eingang 
"impulse" ein Signalwechsel erkannt wird. 

 

Abbildung 2-3 
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3 Anhang 

3.1 Service und Support  

Industry Online Support 

Sie haben Fragen oder brauchen Unterstützung?  

Über den Industry Online Support greifen Sie rund um die Uhr auf das gesamte 
Service und Support Know-how sowie auf unsere Dienstleistungen zu.  

Der Industry Online Support ist die zentrale Adresse für Informationen zu unseren 
Produkten, Lösungen und Services.  

Produktinformationen, Handbücher, Downloads, FAQs und Anwendungsbeispiele 
– alle Informationen sind mit wenigen Mausklicks erreichbar:  
https://support.industry.siemens.com 

Technical Support 

Der Technical Support von Siemens Industry unterstützt Sie schnell und kompetent 
bei allen technischen Anfragen mit einer Vielzahl maßgeschneiderter Angebote 
– von der Basisunterstützung bis hin zu individuellen Supportverträgen. 

Anfragen an den Technical Support stellen Sie per Web-Formular:  
www.siemens.de/industry/supportrequest 

Serviceangebot 

Unser Serviceangebot umfasst, unter anderem, folgende Services:  

 Produkttrainings 

 Plant Data Services 

 Ersatzteilservices 

 Reparaturservices  

 Vor-Ort und Instandhaltungsservices 

 Retrofit- und Modernisierungsservices 

 Serviceprogramme und Verträge  

Ausführliche Informationen zu unserem Serviceangebot finden Sie im 
Servicekatalog: 
https://support.industry.siemens.com/cs/sc 

Industry Online Support App 

Mit der App "Siemens Industry Online Support" erhalten Sie auch unterwegs die 
optimale Unterstützung. Die App ist für Apple iOS, Android und Windows Phone 
verfügbar: 
https://support.industry.siemens.com/cs/ww/de/sc/2067 

 

https://support.industry.siemens.com/
http://www.siemens.de/industry/supportrequest
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/de/sc/2067
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3.2 Links und Literatur  

Tabelle 3-1 

Nr. Thema 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link auf die Beitragsseite des Anwendungsbeispiels  

https://support.industry.siemens.com/cs/ww/de/view/61450284 

3.3 Änderungsdokumentation 

Tabelle 3-2 

Version Datum Änderung 

V1.0 07/2013  Erste Ausgabe 

V2.0 06/2016 Bilder und Formulierungen angepasst  

Kapitel 2: Erläuterungen der Bausteine nicht mehr in 
Tabelle 2-1, sondern in den Kapiteln 2.2.x integriert  

V3.0 03/2017  Struktur der Bibliotheksbeschreibung geändert 

 Änderung der Bibliotheksbeschreibung aufgrund von 
Änderungen in der Programmierung des 
Funktionsbausteins "LSitop_PseDiag" 

 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/de/view/61450284
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